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WinPix32 —  SSTV for Windows 95/98/NT

Welcome

Welcome to WinPix32.  We feel that it provides the most complete SSTV system for use on Windows 95/98 or Windows
NT. If you have a favorite SSTV mode, this program probably supports it. WinPix32 supports 39 SSTV modes.

The program has been designed to give you the most flexibility to run SSTV the way you want. Because of this flexibility, the
program may seem complex at the beginning, but if you spend time using the Help system and experimenting with the features,
the complexity will soon disappear.

In addition to all of the SSTV functions, the program provides extensive features for adding text and drawing shapes on images.
Image manipulation features allow you to sharpen or soften an image; adjust the brightness, gamma and contrast; repair bad
lines; or add special effects.

A closely integrated program called PixLib32 extends the capability of WinPix32 to add a complete thumbnail library system. The
library system allows you to save SSTV images the way you prefer while giving you the ability to easily edit the stock of saved
images.  You are not limited to a single library on screen. Instead you can have one library present that will automatically accept
your new SSTV images and other libraries that are being used to recall images for transmission.

You can insert images on top of other images. Add your mug shot in the corner of a picture you are sending. These insertions can
even be "see through" if desired.

The program will automatically format a QSL card from any picture or add the typical text used in Contests or with DX contacts.

Create a library of “overlay” images that can be used to frame any image in your collection. Do this by collecting frames or making
frames in your favorite “drawing” program and then use WinPix32 to define the area in the frame that will be “transparent”.

System Requirements

Operating System:

WinPix32 is a Windows program and requires Windows 95/98 or NT for operation.

Processor and Memory:

The minimum processor is a 486/66 DX with 16 Megs of RAM. This combination will operate properly, but may be rather slow in
some image processing tasks.  A Pentium 90 or faster is recommended.  More memory will provide more flexibility in multi-
tasking.

Video Card and Monitor:

SSTV images are received in a 24 BIT mapped format.  Windows handles 24 BIT (True Color) and 15 BIT (High Color) images
in approximately the same manner and will provide a rapid display of the image if the video card is capable of handling either
“True Color” or “High Color”. If your video card is limited to 256 colors, WinPix32 will use a “universal” palette of colors to display
the image and a dithering method of your choice.  The resulting images will be rather grainy. The dithering will try to fool the eye
into seeing the unsupported colors in the image. While a 256-color video card will work, it is not recommended.  A “True Color”
or “High Color” card is strongly recommended.

With monitors smaller than 15 inches, a Windows screen resolution of 640 x 480 is recommended.  With larger monitors you
may prefer an 800 x 600 resolution or 1024 x 768.  Although this requires more memory on the video card, the feeling of more
“room” on the screen to sort pictures is an advantage.  SSTV modes that transmit 480 lines will display better on an 800 x 600
or larger screen.
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Sound Card:

Any 16 BIT Windows compatible sound card should accommodate WinPix32. The program uses the stereo feature of the sound
card to support two-channel operation. "Bugs" in some sound card "drivers" can present a problem and result in picture "loss of
synch".  Creative Labs "Sound Blaster" systems have been good performers.

General Operation

Program Organization
The program is organized around a multiple image format. This organization allows any number of images to be loaded into the
program and displayed at the same time. Each loaded or received image is in its own window and the window is the proper size
for the image.  In the case of large images, the window becomes scrollable

As an image is received, a window, to hold it, is created by the program. Other images can be loaded into the program and/or
edited while the reception is in process. The windows are independent of each other and can be moved about the screen at your
convenience.

How you use the program depends on your preference and on the size of your monitor and the display resolution.  With a larger
monitor, you can increase the screen resolution to 1024 x 768 and have more room to work with pictures.  A smaller monitor
would leave the small format (320 x240) images too small if the higher resolution was used. Here a screen resolution of 640 x
480 is better.  You may prefer to use two instances of the program at the same time to provide more "room".

Additional flexibility is provided through a table of "options" which is accessed through the Options/Other Options menu item.
Here you may want to stay with the default settings until you become more familiar with the program.

 When working with images, the UNDO command will be your friend. Clicking on this tool bar item or selecting "Undo
Changes" from the Edit menu will always allow you to return to the original image.

Many of the dialog boxes (e.g. Receive and Transmit) will initially be placed in the upper left-hand corner of the pro-
gram window. You can drag them to whichever location you prefer and the program will remember.

Multiple Instance Operation
WinPix32 is designed to facilitate multiple instance operation. However, with a  larger monitor running at 1024x768 or higher
resolution, you may feel that there is enough room to work within a single instance. The Options/Other Options                                                                         menu allows you
to select an option that will automatically load two instances of WinPix32 at startup.

Clicking on this icon will load a second instance of the program or transfer to the other instance if it is already loaded.  You
would then typically use one instance for receiving images while the other instance is used to prepare images for transmis-
sion. However, complete flexibility still exists. If you want to "replay" a received image, you just bring down the transmit

dialog within that instance and transmit.

Anytime you want to move to the other instance, you just click on the toolbar icon.

Tool Bar and Status Bar
The Tool Bar can be moved from its default location at the top of the screen to any other location you prefer. The mouse controls
the movement of this "Docking Tool Bar". Put the cursor just to the left of the first icon and press the left mouse button. You can
now drag the tool bar to a new location. If you release the mouse button somewhere in mid-screen, the tool bar becomes a mov-
able window. If released at one of the extremes of the WinPix32 window, the tool bar will be attached to that edge. The process
of moving the tool bar requires a little practice.
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The Status Bar is unique in one respect. The last panel on the right is both a button and a display. If the button is labeled "Select
Save Folder", you can click on it to select the default save location for your images. When a Thumbnail Library is designated as the
storage area, the button no longer operates and the label just displays the library's name.

Getting Started

Setting Your Time Zone

Windows 95/98/NT has a “Date/Time” function in the  “Settings/Control Panel” that sets the time zone and the
daylight savings information. This has probably already been set. If not, you should do this to provide the data
needed to compute UTC times.

Connecting the Transceiver

Adapters are available to go from the 1/8 inch stereo phone jacks used on sound cards to RCA type plugs. The
"stereo" feature of the sound card allows the program to select one of two channels (Left or Right). This
allows you to connect to two transceivers (e.g. HF and VHF) and move between them within the software

The above adapters work well to separate both the two input and the two output channels. Another adapter
available is a cable that has a 1/8-inch stereo phone jack at one end and branches into two male RCA plugs at
the other.

WinPix32 accesses your sound card’s A/D and D/A converters through Windows. If you are not sure of
compatibility or if you later experience difficulties, make sure your sound card is operating properly under
Windows. A test for this is to record and play back a “WAV” file using the Windows “recorder” software
supplied with your sound card. You should be able to record the audio output of your transceiver (any QSO)
and play it back.

• Connect from a transceiver output, which is independent of the volume control, to one channel (left or right) of the "Line
Input" of the sound card.

• Connect from the same channel of the speaker output (use a splitter adapter to allow the speaker to still be connected) to
an input of the transceiver. This can be an "input" such as AFSK or "Phone Patch". Some users prefer an actual switch at
the microphone input to change between microphone and SSTV audio.

You may want to add circuitry to activate the transceiver's PTT line. If you have RF pickup or hum an isolation transformer is
recommended for the speaker output to transceiver line.

Controlling the Sound Card's Mixer
A standardized sound card mixer is included as a part of Windows 95/98 or Windows NT.

Double click on the “speaker” icon in the lower right corner of the screen!

The first mixer screen that appears controls the OUTPUT of the sound card. This will be the mixer used to set
the transmit levels to your transceiver and it is controlled directly by WinPix32.

Since you will be using the Line-In for your SSTV signals from the transceiver, you should remove any check
mark that is in the section under “Line-In”. If this item is “Selected”, the output of your transceiver will play
through to the line output and speakers during SSTV reception. This will complicate the use of VOX or a PTT
circuit.

Gaining access to the mixer that controls the INPUT to the sound card is next.

Click on “Options” and then “Properties”. The “Properties” box will show that “Playback” was selected.  The
“volume controls” checked should include “Volume Control” and “Line-In” as a minimum.
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Now select “Recording”. Make sure that both the “Recording Control” and “Line-In” is checked.

Click on “OK”, and the “Recording Control” mixer will appear.

Make sure that “Line-In” is selected. If you have a computer with a microphone, make sure the “Microphone” is
NOT selected or room noise will be superimposed on your SSTV signals resulting in poor pictures. The “Line-In”
levels will be used to set the input signal level to the sound card from your transceiver.

While the mixer is present, you can set the levels into the sound card.

Setting Sound Card Levels

• Select the Receive mode of WinPix32 by clicking on the green "ear" icon, using the Alt-R shortcut key, or selecting Receive
from the Action menu.  If signals are being sent from the transceiver to the sound card, the "Level" will be indicated just below
the SSTV mode family display in the Receive dialog box.

• Get the mixer back by selecting it in the Windows task bar.
• Move the mixer control to a location that allows you to view the WinPix32 Receive dialog box in the background.
• Use the “mixer” to adjust the Level to a value somewhere between 20 and 50 percent. This is not that critical since values as

low as 10 percent or as high as 100 percent can work quite well. Low settings can be more sensitive to QSB while a high set-
ting can result in sound card distortion in the presence of QRM.  It is best to use a SSTV signal for the adjustment since voice
is too inconsistent in level.

Following the setting of the proper level, close the mixer.

Calibrating the Sound Card
The oscillator that controls the sound card’s timing is crystal controlled and quite stable but the accuracy of these oscillators will not
satisfy the needs of SSTV. WinPix32 provides an automatic means for measuring the frequency error of the sound card’s oscillator.
The program then uses this data to calibrate the “sweep times” in the software.
The automated method uses another SSTV station’s signal for calibration and the program will not allow you to transmit
a picture until after you have performed this calibration at least once.

• From the Action menu select Receive. Alternatively click on the “green ear” icon or use the short cut keyboard option of Alt-
R.  The Receive Control dialog box will appear.

• At the end of the line that says “Synch Start” is a box that says either “Any”, “Prefer”, “Family”, or “Mode”. Set this to “Any” us-
ing the up/down spinner.

• Click on “Calibrate” and wait for a picture to start.  When a picture is received, the it should come down straight although it may
be offset a small amount to the left or right.

• If the picture was received correctly, you can tell the program to save the new correction.  The calibration number will appear in
the "Signal Processing " dialog box.

If the error is in excess of 200 parts per million, you should probably repeat the calibration to verify accuracy.  Receiving a strong
station should result in errors that are consistant within 10 parts per million. Errors in excess of 3000 parts per million are very sus-
pect. Here you should reset the value to zero (Signal Processing dialog box) before repeating the calibration.

Some sound cards, fortunately very few, do not hold the same timing for "recording" and "playback".  These cards could
transmit slanted pictures while receiving perfectly timed pictures.  The Signal Processing dialog box has a place to enter
"Xmit Error".  This would be the difference between the Receive and Transmit timing.  Hints on finding this error value are
located in “Hints and Reminders”.

Signal Processing Options
In the “Options” menu select "Signal Processing".
The resulting dialog box has an item labeled “Present Sound Card Timing”, and it will show the stored number.
If you decide to repeat the calibration, but feel that the stored number is probably correct, DO NOT RESET the stored number to
zero. If you want to start over, the number can be reset to zero.
While this dialog box is present you may want to select the other items displayed.
• Horizontal Synch. Option
• Image Stack
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 Setting the Transmit Level

To set modulation level, make sure you are on a “dead” band and that the transceiver is into a dummy load. Then take the fol-
lowing steps:

• Using the File menu, get any image into the program. When the image has been loaded, the Transmit tool bar icon will show
red.

• Click on this icon to bring down the Transmit dialog box and select the Scottie 1 mode by simply hitting the S key on the key-
board.

• Select the channel to be used (Left or Right) by clicking on the channel select button.
•  Click on Transmit!
• Put your transceiver into the transmit mode and adjust the output volume of the sound card using the “slider control” in the

Transmit dialog box to achieve the desired output power (SSB) or deviation (FM).
• Take the transceiver out of the transmit mode and click on “Cancel” in the Transmit dialog box. This will close the dialog box.

WinPix32 will remember this setting.
Some sound cards will not support the “slider control”.  In this case you will have to use the mixer “Volume” setting to set the level.

The Menu Summary (details in later pages)

Files
Open  Used to load an image
CQ Image Used to call the image you select for the “CQ Image”
Mug Shot Used to call the image you select for the “Mug Shot”
73 Image Used to call the image you select for the “73 Image”
QSL Image Used to call the image you select for the “QSL Image”
Select Source Select a TWAIN image source
Acquire Acquire an image from a TWAIN source
Close Close the current image
Save Save the current image
Save As Bring up the Save As dialog to save the image
Print Print the current image
Print Preview View the image as it will be printed
Print Setup Set the printer information
Delete Delete the current image
Rename Rename the current image

Edit
Undo Changes Undo the Latest Changes to the Image
Cut Cut the Image and Place it on the Clipboard
Copy Place a Copy of the Image to the Clipboard
Paste Load the contents of the Clipboard
Inset from Clipboard Inset the contents of the Clipboard into the current Image
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View
The View menu allows you to enable or disable the display of the Tool Bar and Status Bar. Because these controls are used exten-
sively it is recommended that both be displayed.

Image
 Dithering Select the preferred dither method for reducing the color count in images.
 Reduce Color Reduce the color content of an image.
 Orientation Rotate or Flip an image
 Resize Resize an image
 Crop Select a portion of an image
 Construct Overlay Convert an image into an Overlay where a portion of the image becomes transparent.
 Make 24 BIT This command simply converts any image to 24 BIT format. It does not add colors.
 Set Default Image 1 When clicked, this menu item designates the current image to be Default Image 1 .
 Set Default Image 2 When clicked, this menu item designates the current image to be Default Image 2 .

Options
Signal Processing This brings down a dialog box the sets sound card processing options.
Header Options The resulting dialog sets the header message and provides for a custom header.
Other Options The resulting dialog sets the majority of program options.
AutoRestart Enables the AutoRestart function.  This will  restart a picture if an acceptable VIS code is found.
Scottie DX Prefer AVT 188 and Scottie DX have the same VIS code.  This item sets the preferred default.

Action
Receive Brings up the Receive dialog box and starts the receive process
Xmit Brings up the Transmit dialog box
Get Thumbnails Loads or Calls the Thumbnail Library Management program (PixLib32)
Get Other WinPix Loads or Calls another instance of WinPix32
Select Preferred Modes Brings up a dialog box to be used to select the preferred SSTV mode list

Tools
Add Text Assigns a Text Tools dialog box to the current image
Get Text List Assigns a Text List dialog box to the current image.
Draw Tools Assigns a Draw Tools dialog box to the current image
Image Tools Assigns an Image Tools dialog box to the current image
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Receiving
Starting Image Reception

Alt+R
Clicking on Receive in the Action menu, or the Green Ear icon in the tool bar, or using the short cut key will bring down the Receive
dialog box. When this happens, the program will begin processing data from the sound card. The channel select button (just above
the spectral display) should be used to select either the Left or Right channel of the sound card's input data. The level of the input
signal is displayed just above the channel select button. The "Synch Option" is displayed just above the mode select boxes.

The three buttons in the top row are the primary controls for reception.  The second and third button change function and label dur-
ing the receive process.

• Clear Button This button will interrupt the reception process and close out the window holding a partial picture. The button is
used primarily to abort a false start or give up on a picture received under poor conditions.

• Force  This button begins with the label "Force". If you miss the VIS code but know the SSTV mode you are hearing,
you can set the mode and then force the start of reception. If you have the incorrect mode set, the result will be garbage.

• ReSynch When reception starts, the Force button label is blank for a few seconds while synchronization is in process.
Following this the label changes to "ReSynch".  If the picture did not synchronize properly, and the Synch. Pulse indicator is
registering at least 50%; this button will restore proper synchronization.

• Cancel This button reads "Cancel" while reception is not in process. It will close the Receive dialog box.
• Stop When reception is in process, the label on the third button changes to "Stop".  The button will now manually end

the picture. This is useful if you started receiving a picture late. When you hear the picture come to an end, click Stop and the
partial picture will remain in its window.

Note that the dialog box can be minified using the usual control in its title bar. Reception will continue even though it is minified.

Other
Options

Interaction with Image Transmission
The program is designed to manage the sound card without closing the Receive dialog box dur-
ing transmission. You can bring up the Transmit dialog box at any time. When transmission
actually starts, the receive process will be stopped and the transmission will take over the sound
card. When the transmit cycle ends, the Receive dialog will again begin taking data from the
sound card.

The above process works just as well with two instances of the program. The start of a transmit
cycle will be detected in another instance and any receive action will be halted.  Again, when the
transmit cycle ends, the receive process will be restored. In all cases, the Receive dialog is not
closed.  Only the data processing is halted.

Sync Start VIS Filter Calibrate

Save Auto Tune To Clipboard

Keep Header Mode Select Boxes Audio RIT

Spectral Display
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Other Receive Options

Synch Start
If you miss the VIS code and DO NOT know the SSTV mode you are hearing, the "Synch Start" option can help identify the
mode and start receiving the picture.

When you enable "Synch Start", the program looks for the timing between line synchronization pulses and attempts to find a
SSTV mode that matches the timing. If it finds a mode it will begin to receive the picture in that mode. The program will only
examine those modes allowed by the selected "VIS Filter".

Since the synch. pulses are much shorter than the VIS interval, they are more sensitive to noise.  As a result this method of
finding the mode is not as reliable as the VIS code. Under good signal conditions it works quite well.

Several SSTV modes have identical times between pulses so the program will select the first one it finds in the search pattern. If
M3 is being sent, the program will select M1 since it has the same line timing and occurs first in the search pattern.

Auto Save
This option displays the default image format that will be used by the "File/Save" menu command or the automatic save func-
tion. Enabling this function in the Receive dialog will result in each image being saved at completion.
You can turn this option On or Off at any time.  Therefore, you may elect to leave it Off until you see a good picture that you want
to save. As long as you enable the option before the picture is finished, the automatic save will occur.
 If you want to save an image manually, just use the tool bar icon. Both the "Save" and automatic save function will save the
image at the location shown in the right pane of the status bar.

Keep Header
If this option is enabled, the window that is created, to hold the incoming picture, will be high enough to contain both the image
and the header. The typical small format mode may have an image size of 320x240 with a 16-line header. In this case the win-
dow will be 320x256.

If the option is not enabled, the window will only be as large as the image portion. The reception will then start near the BOT-
TOM of the window.  This will display the header.  As the picture progresses, it will move to the top of the window and will even-
tually overwrite the header as it gets to the bottom.

If you start receiving a picture late, you will be using the "Stop" button in the Receive dialog box when you hear the picture end.
At this time the program will "roll" the image so the last line received will be at the bottom and any portion of the picture that was
there will be "rolled" to the top.

VIS Filter
Because WinPix32 supports so many modes, the probability of a false start due to QRM or QRN is higher. By controlling the
modes that will be recognized by the program, the probability of a false start can be reduced. The VIS filter has four options:
• Any --- If this selection is made, the program will respond to any of the supported SSTV modes. With this selection, the

probability of a false start is the highest.
• Prefer -- This selection will allow the program to respond to any mode that is on YOUR list of preferred modes. You can

establish this list based on the modes you regularly use.
• Family -- This selection will restrict the recognition to modes that are in the same Family as the default mode.  If the de-

fault is displayed as Scottie, only the 5 modes in this family will be recognized.  This is a useful selection for "nets" where
the modes are usually within the same family.

• Mode -- The only VIS code that will be recognized here is the current default mode.
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Auto Tune
The program uses two forms of automatic tuning.
•  For all modes, the start tone and VIS interval are used to measure the tuning error.  This sets the "Audio RIT" to a value that

then corrects for the tuning error.
• The PD and HQ families have the capability to continuously correct for tuning errors caused by relative drift between the send-

ing and receiving station.
In most cases, the AutoTune should be enabled, but, under poor conditions, the accuracy will also be poor. In this case it should not
be enabled.

Calibration
To calibrate the sound card clock against the timing of another station:
• Click on "Calibration"!
• Wait for the start of a SSTV picture. The station you are receiving should have good signal strength and you should have rea-

sonable confidence in his timing calibration.
The picture should come down straight but may be offset a small amount to the right or left. This offset is the result of the program
correcting for the error in the sound card clock and is a temporary condition.
When the picture is completed you will get another dialog box which will display the computed sound card error in parts per million.
If the received picture was straight and reasonably free of noise, tell the program to save the new correction.
Most sound cards will have a clock error less than plus or minus 200 parts per million. Some cards, however, can have considerably
larger errors. The image quality will not be effected by a large error but, if you get a large number, you should repeat this calibration
to make sure it is consistent. The answers should not differ by more than about 10 parts per million from one calibration to another.
Numbers as high as 3000 parts per million have been seen but numbers higher than this should be suspect.

You can also use this feature to just measure the relative error between you and another station. If you run a calibration on a station
that is having problems with "slanted" pictures, the difference between the New and Old calibration numbers tell the number of parts
per million difference between you and the other station. Since this is just to help the other station's calibration, DO NOT SAVE THE
NEW VALUE.

Mode Select Boxes
When the dialog box first comes down, you will notice that the mode "Family" is highlighted in the left of the two mode select boxes.
Selecting a mode can be done using either the keyboard or the mouse.
• Keyboard ----- Type the first letter of the desired mode family. The family will change to the desired family. If more than one

family ( P & PD) begin with the same letter, just type the letter a second time. Now hit the TAB key to move the highlight to the
right mode selection box. Now type the number/letter of the mode within the family.

• Mouse -- Both of the mode selection boxes are "drop down combo boxes". Click on the down arrow for the left box first and
select the family. Then click on the down arrow for the right box and select the family member.

Selecting the default mode in the Receive dialog box is only necessary if you have restricted the VIS Filter to "Family" or "Mode".

To Clipboard
The button to the right of the channel select button controls the automatic transfer of a received image to the clipboard.  When the
button is clicked the label will be "-->C". If this label is showing, the received image will automatically be placed on the clipboard.
Clicking on the button a second time turns off the function and the label will be blank.

This feature is useful if you want to quickly inset the last picture into your next transmitted picture. This is a common procedure for
DX contacts. You can also use this to quickly transfer a picture between instances of WinPix32.

Keep in mind that this process will overwrite any other picture that is already on the clipboard.
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Audio RIT
The program uses the value displayed in the "Audio RIT" to modify the detected SSTV tones and correct for errors in tuning. The
AutoTune function sets this value but you can manually change it during reception to center the tuning indicator, which forms a part
of the spectral display. Clicking on the Up or Down arrow to the right of the indicator changes the value in increments of 10Hz. The
Audio RIT has a range of plus or minus 100Hz.

A reset button is available to quickly set the value to zero.

Spectral Display
The spectral display consists of three parts:
• The primary display shows the spectral distribution of the incoming signal. It is updated every 500 milliseconds . The vertical

axis of the display has a range of 30dB.  The green line in the display is only to remind the user that this is the location of the
1200Hz synch pulses.  When a picture is being received, the background color changes from a light to a dark gray.

• The band just to the right of the primary display is a tuning indicator.  When a picture is being received, a yellow dot will display
the tuning error based on the current synch pulses. Since the AVT modes do not have synch pulses, the display is not used for
these modes. Under good signal conditions, this display can be used to correct for errors using the Audio RIT. Under poor
conditions, the indicator will be very erratic. THE USE OF THE AUDIO RIT IS RECOMMENDED ONLY TO CORRECT FOR
LARGE OFFSETS.

• At the far right is a band that indicates the "reliability" of the synch pulses. If all 4 out of the last 4 synch pulses were detected,
the band will be all green. If only 1 out of the last 4 was detected, the lower fourth of the band will be green and the rest will be
red.  DO NOT TRY TO USE THE RESYNCH BUTTON UNLESS AT LEAST HALF THE DISPLAY IS GREEN.  This result
could cause more harm than good.

Saving Pictures

Save Location Rules

Ctrl+S

If a picture is modified, you can use the "Save" command, short cut key, or Tool bar icon to save it.  Where will it be saved?  This
is a common question and the location and format depends on several things.
• If the picture was loaded from storage (hard drive, floppy, ZIP etc.) it will be saved back to its original location.  It will also be

saved in its original format (extension) it that format is supported.
• If the above format is not supported (read only format), you will be notified that the image will be saved in the "Default" for-

mat. The location will remain the same as its original storage location.
• If the picture was loaded from the clipboard or received as a new SSTV picture, it will be saved at either the "Default" location

or in a designated Thumbnail Library. The format will be in the "Default" format .

Setting the Default Save Location
When the program saves a picture using either the Automatic Save option in the Receive dialog or in response to a user save
command, the location for the "Save" is determined by one of two ways.
• If the far right panel in the program's status bar reads "Default 'Save' Location", you can click on the panel to set the default

storage location. A standard dialog box will appear to allow you to select the default folder. Pictures saved while the panel
reads "Default 'Save' Location" will then be saved to this new location.

• From within the Thumbnail Library Management program (PixLib32) you can click on the far right panel of that program's
status bar. When no library is designated, the button is labeled "Set 'Save' Library".  When you click on the button, the name
of the currently selected library will appear in the panel and, when you return to WinPix32, the far right panel in its status bar
will show the same library name. . Pictures will be saved to the library shown.

Saving pictures to a Thumbnail Library is the recommended approach. It provides an organized method for later review and dele-
tion of unwanted images. For some users, creating an empty library on a floppy disk at the start of an SSTV session may be the
answer.
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Setting the Default Image Format
Setting the format for images saved by the Automatic Save in the Receive dialog or by the use of the Save command is done in the
Options/Other Options dialog box.

Six image formats are available.
• JPG usually results in the smallest file size and is a good choice for 24-bit images. The form of compression results in some

loss of picture detail but the loss is usually not noticeable. It is not a good candidate for high contrast "cartoon" type images.
Consider PNG for these or reduce the colors and use GIF or TIF.

• PNG also does a good compression job on 24-bit images but is not quite as compact as JPG
• GIF is a good choice for 256 color images. It does not support 24-bit images.
• TIF is also a good choice for 256 color images. The compression is worthless for 24-bit SSTV images.
• PCX is the default file type for the old Windows Paint Program
• BMP is the native Windows format. It results in the largest file size but it is useful if you want to later use the picture for "wall

paper".

Adding Text

The Text Tool Box

Adding text to a picture begins with deploying the Text dialog box. This is accomplished by selecting "Add Text" from the Tools
menu or clicking on the "A" icon in the tool bar.

This dialog box is attached to the picture that was highlighted at the
time the dialog box was deployed. That picture's name appears in the
title bar of this dialog box.  Text entered with this dialog box will ONLY
be added to that picture. After adding your text, close the dialog box by
clicking a second time on the "A" icon.

The dialog box is rather complex because the program provides many text-
related features.  (See “Other Text and Drawing Features”)
• Font Selection
• Color Selection
• Color Fade Options
• Background Effects

Text is added to the picture either through typing or by selecting a com-
plete message from a text list.

Typing Text
Text can be typed directly into a picture in one of four directions.
• Left to Right
• Top to Bottom
• 45 degrees Down
• 45 degrees Up

1. Click on one of the direction arrows.  The arrow will turn green.
2. Move the cursor to the area of the picture where you want to type.
3. Hold the left mouse button down and position the gray box to the start of the text. The typed text will be the height of the gray box

and the starting location will align with the left edge of the box. For VERTICAL text, the left edge of the gray box will mark the
CENTER of the first letter.

4. Release the mouse button.
5. Type the text and use the "Enter" key to end the process.
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Using the Text List
The text list provides a simple means for adding any of 16 prepared messages to an image.  When you click on "Text List" in
the text dialog box, the list dialog box appears. You can also access the Text List box directly by using the “TL” tool bar icon or
clicking on the “Get Text List” item in the Tools menu.

This box has room for 16 messages and these are entered by simply selecting
the line you wish to edit and typing the new text into the edit box at the top of
the dialog box.  The text will be added to the image in your default font style.

1. After selecting the message you want to use, click on “Add Text”.
2. Text will appear in the image in the proper font and a white color.
3. Move the cursor to the text and, with the left mouse button down, drag the

text to the desired location.
4. Release the mouse button and the text message will be added to the im-

age.
5. The “Text List” will remain until the “Done” button is clicked or the “Text

Tools” dialog box is closed.

In the above example, note that most of the entries end in a backslash charac-
ter or a backslash character plus a number. These are automatic scaling com-
mands.

The font size that is selected is one that will not exceed the specified horizontal size. Because some fonts are quite lim-
ited with regard to available point size, your text could be noticeably shorter than the specified percentage.

Drawing Tools

The Draw Tool Box
To draw in an image you call the Draw dialog box.  This is done from
the Tools menu or by clicking on the "Pencil" icon in the tool bar.
This dialog box is attached to the picture that was highlighted at
the time the dialog box was deployed. That picture's name ap-

pears in the title bar of this dialog box.  Drawing done with this dialog
box will ONLY be added to that picture. After adding your drawing,
close the dialog box by clicking a second time on the "Pencil" icon.
The dialog box is rather complex because the program provides many
drawing-related features. (See “Other Text and Drawing Features”)

• Pen Width
• Color Selection
• Color Fade Options
• Background Effects
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Drawing Shapes or Lines
The drawing process begins by selecting the object to be added to your picture.

When you click on the desired shape, it will change from red to green.  All of the shapes act the same way. The line (far left) is just a
little different.

1. After selecting a shape, the text in the line above will indicate your selection.
2. Move the cursor to one corner of the shape. The upper left corner is usual

but is not required.
3. Hold the left mouse button down and increase the size of the shape.
4. When you release the left mouse button, the shape will be added to the pic-

ture.
If you hold down the "Shift" key while drawing the shape, it will draw circles or squares instead of rectangles or ellipses.

A special drawing feature involves the use of the right mouse button. If, after selecting the shape, you click the right
mouse button any place within the picture, the shape will fill the entire picture. This is handy for adding frames.

The line tool is similar to the shape tools but does not use color fading. Only the start color is used for both the Draw and Back-
ground color.  Holding the "Shift" key while drawing a line causes the line to be either horizontal or vertical. The choice depends on
which condition most closely approximates your drawing motion.  In addition, the line tool does not respond to the right mouse but-
ton.
 You may want to select "None" for the background effect . Shadow and extrusion effects are not attractive when applied
to lines.

Other Text and Drawing Features

Font Selection
The font selection dialog has a standard Windows format. The color selec-
tion is only the primary color of the font. The detailed color selection is done
from the Text dialog box. The font size applies to typed text and text from
the "Text List" ONLY if it is not set for automatic size adjustment .

Color Selection
The lower section of the dialog box is used to select the various colors that can be
applied.  This same selection process applies to both the Text and Drawing Tools.

Four color-assignments are available. They select the colors for the "Foreground" (in this case Text) and the "Background".  The
background includes shadow, extrusion, and outline colors. Both the foreground and background have two color selections.  These
are for color fading.  This fade option can be assigned as "top to bottom" or "left to right". The labels are set by the selected fade
option and, in the above example, they are "top to bottom".

Click first on the selection to be made (Text Color & Top in the example). You then click on the desired color in the color chart at the
right. When the assignment is made, the selection will move to the next item (Text Color & Bottom in the example). This allows you
to rapidly select all four color options.
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Fade Option
The button labeled "Fade Opt" controls the manner in which the text or drawing colors will
be applied.  The button toggles through three states.
• Top to Bottom
• Left to Right
• All
The first two are self-explanatory. "All" turns off the fade process and uses the starting
color for the entire object. The example below shows the fade options applied to both text
and drawing items. The left to right example used text from the "Text List".  If the text had
been typed, the fade would have been applied to each individual letter.

Background Effects
Text and drawing tools both have the same options for "Background" effects.

At the right, are five options. These control the category of the background effect. The
"shadow" effect places a copy of the text or drawing displaced to the "Right and Up" or to the
"Right and Down".  The "extrude" effect is similar to shadow except the background effect
fills in the area between the object and its shadow.  The result is a 3D effect. The "outline"
effect just surrounds the object with an outline.

The "Background Depth" control sets the thickness of the outline or the distance of the shadow or extrusion. "None" turns off the
background effect.

Automatic Text Scaling
For text in the "Text List" category, the font point size is adjusted based on the last characters in the text message.

If no backslash is present, the currently selected font size is used. If a backslash and number (1 to 9) is present, the program will
find the nearest point size within your selected font which will span a particular percentage of the picture width.

As an example, if the entry in the "Text List" ends with a backslash and a 4, this specifies a 40 percent width for the text message.
An entry ends in \8 will span 80 percent of the image width. If no number is specified after the backslash, the default is 90 percent of
the width of the image.

Pen Width
The pen width is increase or decreased using the arrow buttons to the right of the pen width display.

The pen width applies both to line drawing and to the drawing of frames.  It is the width of the pen in pixels and is limited to a range
from 1 through 20.
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Image Tools

The Image Tool Box
To modify an image, call the Image Tool dialog box. This is done from the Tools menu or clicking on the "Split Sun" icon in
the tool bar.

This dialog box is attached to the picture that was highlighted at the time the
dialog box was deployed. That picture's name appears in the title bar of this dia-
log box.  Image modifications done with this dialog box will ONLY effect that
picture. After working with a picture, close the dialog box by clicking a second
time on the "Split Sun" icon.

The dialog box is divided into three sections.
1. Overall Adjustments -- This area adjusts the brightness, gamma and contrast of the

image.
2. Special Effects -- Six buttons control special effects
3. Progress Display -- The Plug-Ins special effect requires extensive computer pro-

cessing. The display at the bottom of the dialog box is used only to monitor the
progress of a Plug-In computation.

Overall Image Adjustments
If major changes are made in most of the adjustments, they are not reversible without using Undo.  To illustrate the problem,
consider the following.  If you increase brightness, all of the higher brightness values in the image may be set to maximum.  If you
then reduce brightness, all or these values are reduced but they are still of equal value.  The only adjustment that is reversible is
Gamma.  This is a nonlinear function.  It leaves the maximum and minimum values in the image unchanged but, instead, modifies
the gradient of the intermediate values.  Gamma can be used to change the contrast gradient in either the high or the low brightness
areas of the image.
• Brightness -- This adjustment changes the overall intensity of each pixel's color components.
• Gamma -- This adjustment can be used to increase the gradient in brightness near the bright or dark end of the scale. An

image, that is dominantly dark but still has some light areas, can be modified to bring more detail to the dark areas without
saturating the light areas. In the other direction, a generally bright image with a few dark areas, can be modified to provide
more detail in the light areas without causing the dark areas to go to black.

• Contrast -- This adjustment changes the slope of the intensity about a central value that is based on a histogram for the im-
age. The program provides the capability to modify the contrast for each individual color component or all colors at once.

Click on "Apply" after making the adjustment settings.

Special Effects
The six push buttons control various special effects. (See “Special Effects Details”)
Sharpen
Soften
Repair Line
Emboss
Invert
Plug-Ins
The first three will have more usage than the last three. However, "plugins" provide so much variety that they could become one of
your favorites.
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Sharpen
This button results in an increase in the edge gradients in the image. The result is to make the image more "crisp". Repeated clicks
continue to add to the sharpness but at the expense of overall image quality.

Soften
This function reduces the edge gradients in an image.  It has the reverse effect from the "Sharpen" command.

Repair Line
When this button is clicked, its title changes to "Active".  This has turned on the line repair mode.  Click the button again to turn the
mode off.

Line repair it done as follows:
• With the left mouse button down, move the "cross marker" until the horizontal line is on the line to be repaired.  This will require

careful mouse movement.
• Release the mouse button.
The program will copy the line above the "cross marker" and replace the defective line. If more than one line in a group has been
damaged, you must start repairing the top line first. If the results are not what you want, click on Undo to start again.
When doing major repair, it is a good idea to copy each intermediate good result to the clipboard. This allows you to
recover without the danger of returning all the way to the original image via the Undo command.

Emboss
This effect creates a gray scale image but highlights the image in a way that makes it appear three-dimensional. Using the
"Sharpen" command will increase the "depth" of the embossed image.

Invert
This button simply reverses the colors in an image. It creates a "negative". If used in conjunction with the "Emboss" command it will
reverse the three dimensional effect.

PlugIns
PlugIns were introduced with the release of Adobe's Photoshop 2.5.  They have now grown to be available by the thousands.  They
can be used for simply adding colorful frames around an image. At the other extreme, they can completely restructure a picture into
psychedelic art. Only one PlugIn is shipped with the program but you can easily download others from the Internet. The addresses
given below are, of course, subject to change.

A typical location to download FREE PlugIns is the Filter Factory site:
http://www.netins.net/showcase/wolf359/plugins.htm                                                                                   
The files downloaded from this site must be "compiled" into files that can be read by WinPix32.

The program to accomplish this is also freeware and can be downloaded from:
http://pico.i-us.com/pico/download.htm                                                             
Two files are needed.  One is 1.8 MB while the other is 917KB.

Because of the number of plugins available, you may want to consider a plugin manager. "Plugin Manager" is a shareware program
available from:
http://www.icnet.de/intl/pm2down.html                                                            

In addition to the many free plugins, there are commercial plugins available as well.

Special Effects Details
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To use a plugin you must first tell the program where they are located.  This is done through the Options/Other Options menu item.
• Clicking on "PlugIns" in the Image Tools dialog box will bring down another dialog that will list the plugins available in the direc-

tory you have designated.
•  Selecting one of these and clicking on "About" will show the author's name and copyright information.
•  Clicking on "Apply" will access the plugin's setup adjustments and will show a preview screen.
•  After making the adjustments, click on a "OK" to start the plugin computation. The indicator at the bottom of the dialog box will

trace the progress.  With slower computers and large pictures this can be slow.

Transmitting

Starting Image Transmission

Alt+X

After you have loaded or selected the image you want to transmit, make sure the image is
"highlighted" by clicking on its title bar. Bring down the Transmit dialog box by selecting

"Xmit" from the Action menu, clicking on the red "megaphone" icon in the tool bar or using the short
cut key.

Because of the many features that are available when transmitting, the dialog may seem complex.
Starting with the top two buttons.

• Transmit -- This will start the transmit process in the SSTV mode shown in the mode select
boxes. As transmission progresses, a red line on the left edge of the picture will trace the
progress.

• Cancel - This closes the dialog box when not transmitting an image.
• Stop -  During transmission the Cancel label button changes to Stop.  Clicking this button will

stop the transmission but will not close the dialog box or restart any Receive data processing.

Other
Xmit
Options

 The slider at the bottom of the dialog box sets the output level of the selected channel (Left or Right).  The program remembers the
setting for the individual channel.

Interaction with Reception
The Transmit action sends a message to ALL instances of the program to turn off the "Receive" mode during transmission.
When a transmission ends normally, a receive dialog in ANY instance of the program will again start to process incoming data.  If
the Stop button is used, the the program will not restart any receive data processing.
With most sound cards, trying to open a Receive dialog box during transmission will result in an error message telling you the sound
card is busy.

Contest/DX Station ID Channel Selection

Send QSL Mode Selection Header Control

Repeater Tone Mode Lock Aspect Control
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Other Xmit Options
Contest and DX

Clicking on this button formats the image for transmission based on the selected SSTV mode. It also brings down a dialog box.
This dialog box is used to enter data that will be added to your picture in a format typical of Contest or DX contacts. The font style
and color properties will be determined by the selection in the Option/Other Options dialog box.
• Enter the call sign of the station you have contacted ( or any other message).
• If you want, you can change the default signal report.
• Enable the Signal Report or Contest Number options.
• If you want, click "Preview" to view the picture before you start to transmit.
• Click on "Transmit" to start transmission.

The contest number will automatically increment if
"Contest #" was selected. You can reset this to 1
with the "Reset Contest #" button.

QSL Card
Clicking on this button formats the image for transmission based on the selected SSTV mode. It also brings down a dialog box.
This dialog box is used to enter data that will be added to your picture to create a QSL card format. The font style and color prop-
erties in your call sign will be determined by the selection in the Options/Other Options dialog box.
• Enter the station's call sign
• If desired, modify the default signal report.
• Enter the frequency in kHz.  This will become the new default.
• If desired, click on "Preview" to view the picture before you start to transmit.
• Click on "Transmit" to start transmission.

If you just want to print a QSL card, select a SSTV
mode such as Robot 72 (it has no header) and then
click on “To Printer” in the QSL Dialog after entering
the needed information.  You must set up the printer
for the postcard format.

Repeater Tone
This button will transmit a 1750 Hz tone for approximately 1.5 seconds. This is used to signal SSTV repeaters. If received, the
repeater will answer with the CW character "K". You then begin transmitting the picture by clicking on "Transmit".
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Station ID
Two forms of automatic station identification are available. The form is selected by clicking on the button that either reads "CW" or
"WAVE".
If you elect to have voice identification, you must record a "WAV" file using a Windows supplied sound recorder. You can give this
"WAV" file any name and can save it in any location. You then must use the button in the Options/Other Options dialog box to desig-
nate this file for station identification.

The CW identification is built into the program.

After selecting either "CW" or "WAVE", you can elect to have the identification placed at the beginning or end of your transmission.
If you select "None", the ID function will be disabled.

 Mode Lock
If you want to add text or drawings to your picture prior to transmission, you should click on "Mode Lock" to format your picture for
transmission.  If you do not use "Mode Lock", you can still add text or drawings to your picture but, keep in mind, that the size of the
total picture may be changed when transmission starts.

Channel Selection
The channel select button (just below "Mode Lock") should be used to select either the Left or Right channel for transmission.  This
should usually be set the same as you are using for reception.  If you want to send a picture on either channel, the program supports
this flexibility.

Header Control
When the program formats a picture for transmission, it needs to know a few things about the header. It does not know if the picture
already has an "old" header attached or if it is a picture with an "unusual" aspect ratio.
• Normal -- If this is selected, the program assumes that the picture does not have a header. It will therefore add header lines at

the top of the picture if the mode definition calls for a header. As an example, a picture for Scottie 1 will be scaled to fit
320x240 and 16 lines will be added at the top. The resulting window for transmission will be 320x256.

• None -- If this is selected, the program will do the following: The picture will be scaled to fit the full size of the mode specifica-
tion (320x256 for Scottie 1) and your call sign and any message will be written in the top lines of the re-scaled picture.

• Overwrite -- This selection tells the program that an "old" header is present in the picture. It will therefore trim the required top
lines from the picture before replacing them with your header.  If you always elect to "Keep Header" during the receive process,
you will probably use this option when you replay old images.

Before transmitting you should quickly check this setting to make sure you have selected the proper option for the pic-
ture you are preparing.

You have the option of selecting a custom header design and adding a message following your call sign.

Aspect Control
Since the program scales the picture to the requirements of the mode, you should tell the program how to handle differences in as-
pect ratio.
• Fixed -- If this is selected, the aspect ratio of the original picture will remain fixed.  This may mean that the picture will not fit

exactly into the area required by the SSTV mode specification. If the picture is "short and wide" then gray area will be used at
the bottom of the transmit window as "fill".  If the picture is "tall and narrow" then gray areas will be placed at the left and right
edges to fill in the transmit window.

• Variable  -- If this is selected, the program will resize the original picture to fit the mode requirements. This may result in picture
distortion.

Most SSTV modes have a 4:3 aspect ratio. If your pictures are at or near this ratio, you can select "Variable". A little bit
of distortion is not noticable and is usually preferred to having gray areas as "fill".
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Supported SSTV Modes
The following table lists the modes supported by WinPix32. Note: The times given are approximate.

† These modes do NOT transmit header lines.  All other modes transmit either 8,  16, or 20 header lines.  The "half line"
modes use 8 line headers. FAX 480 uses a 20 line header.  All the others use 16 line headers.
* These modes only send half the actual lines but the program fills in the remainder to create an image of the size shown.
** The Robot color modes and HQ modes transmit the luminance information in the pixels at the rate shown.  Color informa-
tion is sent at half the time per pixel.
†† Wraase SC2 modes (30, 60, & 120) transmit the Green information in the pixels at the rate shown.  The Red and Blue
information is sent at half the time per pixel.

Family Mode Size µS/Pixel (approx.) VIS code
AVT BW 125 640x400 489 80

AVT 24 256x240†* 260 64
AVT 90 256x240† 489 68
AVT 94 320x200† 489 72
AVT 188 320x400† 489 76
FAX 480 512x480 512 tone
HQ 1 320x240 535** 41
HQ 2 320x240 666** 42

Martin 1 320x240 454 44
Martin 2 320x240 214 40
Martin 3 320x240* 454 36
Martin 4 320x240* 214 32

P 3 640x480 208 113
P 5 640x480 312 114
P 7 640x480 416 115

PD 50 320x240 286 93
PD 90 320x240 532 99
PD 120 640x480 190 95
PD 160 512x384 382 98
PD 180 640x480 286 96
PD 240 640x480 382 97
PD 290 800x600 286 94

Robot BW 8 320x240†* 181 2
Robot BW 12 320x240†* 275 6
Robot BW 24 320x240† 275 10
Robot BW 36 320x240† 431 14

Robot 12 320x240†* 183** 0
Robot 24 320x240†* 284** 4
Robot 36 320x240†* 275** 8
Robot 72 320x240†* 431** 12
Scottie 1 320x240 432 60
Scottie 2 320x240 275 56
Scottie 3 320x240* 432 52
Scottie 4 320x240* 275 48
Scottie DX 320x240 1079 76

Wraase SC2 30 320x240* 368†† 51
Wraase SC2 60 320x240 368†† 59
Wraase SC2 120 320x240 735†† 63
Wraase SC2 180 320x240 735 55
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About the Modes

Conventional RGB Transmission
The majority of the color modes send the red, green, and blue information in each pixel at the same speed.  In general each line
consists of three color-blocks where all of the red is sent followed by the green and then the blue.  Some mode families have gaps
between the color fields while others do not. The order of the colors is also different for the various mode families.
In all of the mode families except AVT, a sync pulse is sent somewhere during each line. All of the mode families except Scottie
have the sync pulse at the start of the line.  Scottie has the sync pulse located ahead of the red field, which is the last field sent in
each line.

Because the three colors are all sent at the same rate, a slight error in the start of a line will result in the picture being shifted to the
right or left but the color registration will not suffer.

Robot Color Modes
In the interest of saving transmission time while still retaining resolution, these mode families do several things.  First the colors are
changed into a luminance field which carries the brightness information of each pixel, as it would be sensed by the human eye.  The
color information is contained in two other fields.  The designation for these fields is generally Y, R-Y, and B-Y.  On receiving these
fields, the needed math is performed to recreate the RGB information in each pixel.

The Robot72 and Robot 24 modes send the Y information at the pixel rate shown in the table and then send the R-Y and B-Y fields
at half the time per pixel.

The Robot 36, and Robot 12 modes go one step farther by sending the Y information for all lines but sending the R-Y and B-Y infor-
mation on alternate lines.

The philosophy behind this approach is that most of the picture information is carried in the luminance field and that the color infor-
mation can be sent at lower resolution. .  As a result this family is subject to color registration problems if a “phase error” occurs or
substantial multi-path reception exists.  When this happens, the color registration suffers.

HQ Mode Family
This family codes the luminance and color information in the pixels using the same method as employed by the Robot family. Like
the Robot family, the color information is sent at half the time per pixel.  As a result this family is subject to the same color registra-
tion problems if a “phase error” occurs or substantial multi-path reception exists.

A sync pulse occurs only every other line. Six fields are sent between sync pulses. The first three are Y, R-Y, and B-Y for the odd
numbered line. The next three are Y, Y-R, and Y-B for the even number line.  The reverse polarity of the color information in the even
number line can be used in conjunction with the information in the odd number line to accomplish continuous automatic tuning.

Wraase SC2 Modes
With the exception of the 180-second mode, the Wraase SC2 modes use a philosophy similar to Robot.  These modes do not sepa-
rate the luminance from the color information but, rather, send the green at twice the resolution of the red and blue.  The red field is
sent at half resolution followed by the green field and then the blue field at half resolution.

Under ideal conditions this approach also works but again timing errors will result in color registration problems.  A secondary issue
shows up when a white pixel follows a black pixel.  Because the red and blue information does not change as quickly, a green
"shadow" will occur. This effect is not noticeable in most images.
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PD Mode Family
This family codes the luminance and color information in the pixels using the same method as employed by the Robot family. How-
ever, it keeps the same timing for the color components as the luminance component. This avoids the color registration problems
that occur if a “phase error” occurs in the picture.

The sync pulse is longer than modes such as Scottie. The 20 millisecond sync pulse is used to continuously correct tuning errors
during picture reception.

A single sync pulse is sent for each pair of lines. Following the sync pulse the sequence becomes Y, R-Y, B-Y, Y.  The first Y is the
luminance information in the odd numbered line and the last Y is the luminance information in the next (even numbered) line.  The
color fields (R-Y & B-Y) are the average of the two lines.

This mode family saves transmission time by sending the color information at a lower resolution in the vertical direction only.  By
keeping the time interval the same for the color and luminance fields, color registration problems are avoided.

Push to Talk Implementation

Com Port PTT
The COM port can control the PTT line through a simple transistor circuit. This approach has the advantage of simplicity. However,
it does occupy a COM port for a very  trivial job. If you are using two transceivers and are using the left and right channels of the
sound card, connect this circuit to the RTS line for the left channel and, another circuit like it, to the DTR line for the right channel.

An alternative to the circuit shown below is to use the “standard” HamCom interface just for the PTT feature. This is useful if you
already have one of the many DOS based programs that use the HamCom interface.
The Options/Other Options menu item allows you to select the number of the Com port to be used.
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Detector PTT
Another approach to controlling the PTT line is to use circuitry to detect the SSTV signal at the speaker output and use this to pull
down the PTT line.

This circuit requires at least 300 mV to trigger.  You should probably have the sound card output set to about 500 mV and then ad-
just the level needed by the transceiver by setting the 1K potentiometer.  It is always a good idea to have the sound card's output at a
reasonably high level and then attenuate (close to the transceiver) as needed.  This reduces the noise and hum pick up by only hav-
ing low level signals near the input to the transceiver.

NOTE:

1. All diodes except the 1N34 are general purpose silicon.
2. The output is a power MOSFET with a 4 Volt turn on voltage - Radio Shack # IFR510 or equivalent.
3. A MINUS 9 Volt battery is required but need only be changed once a year.
4. All capacitors are polarized tantalum.
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Details of WinPix32 Menu Items

File Menu

Open File
This menu item, tool bar icon, or short cut key will bring up a dialog box to allow you to select the image you want to load. The dia-
log box is equipped to display the image statistics as well as a thumbnail preview.
Locate the folder, select the image, and then click on "Open".

Open Blank
This menu item is used to create one of three "standard" size blank images. The background color of these images will be
"transparent" so this is an easy way to start the construction of an Overlay.

Select Source
If one or more TWAIN drivers are installed on this computer, this menu item will be active. If more than one driver is present, you
should use this menu item to select the TWAIN image source.

Acquire
This command will activate the selected TWAIN driver and allow you to load an image from devices such as scanners, video cam-
eras, or digital cameras.

Close Image
This menu item is equivalent to clicking on the X in the title bar.

Save Image
This menu item, tool bar icon, or short cut key will save the image either in its original location and format, the "Default" folder or in
a designated Thumbnail Library. The default format is selected in the Options/Other Options dialog.  The save process is con-
trolled by the "Save Location Rules ".

Save As
This menu item allows you to save an image in any location and in any supported format. It also allows the image to be given a
new name prior to saving it.

Print Current Image
This will print the current image to the default printer with the default setup. If you want to see the format to be printed, use Print
Preview.

Print Preview
Print Preview first displays the way the printed picture will look on the page.  You can access the Print function directly from the
preview display.

Printer Setup
This should be used to set the size and the orientation (Portrait or Landscape) of the printed picture. It will give you full control of
the printer through its driver setup dialog box.
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If the image has not been saved this acts just like the Close command.

If the image has been saved, the image file will be removed from storage.

This is not the recommended method of deleting an image. The recommended method is to perform the deletion from the im-
age library containing the image. This will restructure the library in addition to deleting the image thereby avoiding future error mes-
sages.  The method is to RIGHT click on the thumbnail and delete the image from both the library and the folder at the same time.

Rename Image
Use this to rename an image. You may want to add a more descriptive title instead of the Date/Time title that is automatically applied
to a received image.

This is not the recommended method of renaming an image.  The recommended method is to rename the image using that
feature in the Thumbnail Library Management program.  This updates the library with the new name and avoids future error mes-
sages.  The method is to RIGHT click on the thumbnail and rename the image in both the library and the folder at the same time.

Edit Menu

Undo Changes

BackSpace or Ctrl+Z

The menu command, tool bar icon, or short cut key will undo the last change made to the image. There are three layers of
"Undo". When the first change is made to an image, a primary backup is created. This is never overwritten.  As more

changes are made, the two most recent images are available in the backup list. When Undo is called. The top most backup is recov-
ered. Multiple calls to Undo will then recover the original image.

Cut Image

Ctrl+X

This command, tool bar icon, or short cut key will remove the current from the screen and place it on the clipboard.

Copy Image

Ctrl+C

This command, tool bar icon, or short cut key places a copy of the current image on the clipboard.

Paste Image

Ctrl+V

This command, tool bar icon, or short cut key will load the contents of the clipboard. The loaded image will be given a title that
is a Date/Time stamp.
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Inset from Clipboard
This command or tool bar icon will initiate a sequence that will inset the contents of the clipboard into another image.  After
initiating this command, the tool bar icon will appear as a depressed button. If the left mouse button is pressed while the cursor
is on an image, a "rubber band" frame will be created. As the mouse is moved to the right, this frame will expand with the same
aspect ratio as the clipboard image. When the left button is released, the clipboard image will fill the frame created.  If the right

mouse button is clicked while the cursor is on an image, the contents of the clipboard will be expanded to overlay the entire image.

 "See Through" insets and overlays can also be created by holding a number key down during the process.  If you hold a number
key down while performing the above "Inset" actions, the result will be a blend between the main image and the inset from the clip-
board.  Number keys 1 through 5 result in an inset area that has the color of the clipboard source with a mixture of the clipboard and
main image luminance. Number 1 shows most of the main image luminance and only a little of the clipboard contribution. The result
is a very transparent appearance. As the numbers increase the transparency effect decreases. By number 5 the clipboard inset is
nearly opaque.  Using number keys 6 through 0 has a similar effect except the color of the inset area is controlled by the main image
colors. The resulting appearance is very different.

Image Menu

Dither Method
If you plan to convert images to 256 colors from 24-bit color, you should select a preferred dither method. When fewer colors are
used to display an image, dithering will try to fool the eye by distributing the color error (mismatch) of a pixel among adjacent pixels.
The result is a slightly grainy look but usually a more pleasing appearance than if dithering was not used.  If you prefer not to use
dithering, select "None". Of the other three choices, the "Floyd-Steinberg" is probably the preferred.  The results depend on the par-
ticular picture so it is good to experiment.

Reduce Colors
All SSTV images are initially received in 24-bit color. BW modes are automatically converted to 256 level gray scale. Some images
can actually be improved by reducing the color count. Images that began as cartoons are candidates for color reduction.  Do to ran-
dom noise, pure color fields do not remain pure. Adjacent pixels will vary a small amount from each other. By reducing the colors in
this type of image to 256 or even 16 colors and NOT using dithering, the quality of the image can be improved.

The 15-bit and 12-bit options still result in 24-bit pictures but the low order bits are set to zero during the conversion. 24-bit images
use 8 bits per pixel. The 15-bit and 12 bit conversion only save the top 5 or 4 bits per pixel and set the others to zero.  Why remove
this information?  It can improve some pictures by removing random noise as well.

The remaining options (256, 16, 2, and 256 gray scale) convert the format of the image to reduce its size as well as reducing the
number of colors. The GIF image format will not support 24-bit images and the compression of TIF images is not effective with 24-
bit images.

Orientation

Three options are available from the menu as well as the tool bar.
The first two rotate an image either 90 degrees CW or CCW. Rotating an image is useful for transmitting a tall
narrow image. SSTV formats are more suited to a 4:3 aspect ratio so, sending a picture sideways, is more

efficient.

The third flips the image in the horizontal direction. This is useful for things like pasting a mug shot into another image when you are
facing the wrong direction in the original image.
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 Resize
This menu item provides a number of resizing options.

• Custom This brings down a dialog box that allows you to enter the width and height desired. The program remembers
these values and will use them as the "Custom Default" in future actions.

• Standards Six "standard" sizes are available. If the aspect ratio is not correct you will be asked if the picture should be al-
lowed to distort. If you answer "yes" the picture will distort to fit the selected size. An answer of "no" will result in a "best fit"
resize without distorting the picture.

• x2 Doubles the width and height of the picture.
• /2 Cuts the width and height in half.

This tool bar icon will resize the picture to the "Custom Default" .

Crop
The crop options allow you to cut out a portion of an image.
• 3 "standard" sizes are available to creating images with a 4:3 aspect ratio.
• The "Max 4:3" option will create a crop window with a 4:3 aspect ratio that is the maximum size for the selected image. This is

particularly useful for trimming headers from old pictures.
• The "Rubber Band" option allows you to select any size portion of the image. This is useful for cropping things like mug shots

or other images that will later be inset into another image.

Note that only those items that apply to the selected image will be active when this menu is deployed.

Construct Overlay
When constructing an Overlay image, a color in the original image is selected to become transparent. The three options available
result in an intermediate image being constructed with the colors reduced to 256, 16, or 2.  From this temporary image you can se-
lect the "color" that will become transparent. After the selection, the transparent areas will appear black while the full color will be
returned to the non-transparent areas.

NEVER save an "Overlay" image in the JPG format. The transparent area will be lost.  The TIF and PNG formats are good
candidates for saving an Overlay. When saving an Overlay image it is a good idea to save it in a library dedicated to this form of im-
age.

Make 24 Bit
This simply converts the current image to a 24-BIT format in memory. It does not change the color content of the image, only the
format in which it is stored.

Set Default Images  (CQ, Mug Shot, 73, & QSL)
Four categories of default images are listed in the Files menu.  These are just suggestions.  Designating an image for one of these
categories is done in the Image menu. After selecting the image, simply click on the category in the image menu.  Once an image
has been designated for a particular category, that category will become adtive in the Files menu for automatically loading the image.
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Options Menu

Signal Processing Dialog
The signal processing dialog box sets:
• Synch Processing Options - PLL Robot Modes recommended
• Sound Card Clock Correction - This is automatically set by “Calibrate”  in the Re-

ceive Dialog
• Image Stack - Can be set from 1 through 9. A high number uses more memory

and makes the screen more crowded  This sets the number of received images
that will remain on the screen. As the stack number is exceeded, the oldest image
will be removed from the screen.  If not already saved, this image will be lost.

Synch. Processing Option Details

Four Horizontal Synch. Options are available.
• Free Running -- All modes ignore horizontal synchronization pulses after the

SSTV picture starts.
• PLL Robot Modes -- This is the same as "Free Running" except the Robot mode

family uses a phase locked loop. THIS IS PROBABLY THE PREFERRED OPTION.
• PLL -- All modes that have horizontal synchronization pulses use these pulses in a phase locked loop.
• Triggered Synch. -- This mode is only useful for signal sources such as cassette tape. It is too noise sensitive for "On the

Air" operation

Header Options
This dialog sets the message that will be added to the header following your call sign.

This dialog also lets you enter an addition to your registered call sign if you are operating “Portable”.  The “/” character will automati-
cally be inserted between your registered call and the text added here.  You must restart the program for this entry to become
effective.

You can also elect to use a "Custom" header. This header is stored in a file called "Custom.BMP" located in the WinPix32 root direc-
tory. A simple header is shipped with the program. You can modify this to make your own custom header. The size should remain at
320 x 16.
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Other Options
The Other Options dialog box is used to set most of the program options.
• No VIS=0 (Robot 12) If not checked, you will be able to receive Robot 12 but false starts will greatly increase. QRM can

easily be sensed as a VIS of zero.
• Auto 0 Convert Most languages support the ASCII character that displays the numeral zero with a slash. If this option

is enabled the numeral zero will be converted to add a slash. In languages that do not support this character, do not enable the
conversion

• GIF->256 Colors GIF does not support 24-bit images. If this is enabled, the conversion will be done automatically. If not
you will be asked to OK the conversion each time an image is saved in this format.

• All-> 4:3 Aspect Most SSTV modes use a 4:3 aspect ratio. AVT modes and FAX480 do not. If this is option is enabled
all modes will be RECEIVED in a window having the number of lines in the mode specification.  The width will be adjusted to
result in a 4:3 aspect ratio.

• Expand Small Format With higher screen resolutions, you may prefer to expand the small format (e.g. 320 x 240)
pictures to double the number of lines and double the width. The picture does not get better only bigger. Modes that only trans-
mit half the number of lines (M3, M4, S3,S4 etc) will not be expanded. Robot 36 will also remain at 320 x 240 because the time
per pixel is too small to support expansion.

• Disable Xmit Volume Some sound cards can not be controlled using the "slider" in the Transmit Dialog. If you
have one of these cards, check this option and use the Mixer to set the modulation level.

• Slower Computer The slower computers such as the 486DX/66 can lose picture synchronization at the start of recep-
tion. Enable this option to provide more time to the slower computer.

• Load Two Instances If this is enabled, two instances of the program will be loaded at startup.
• Load Thumbnail Manager If this is enabled, the Thumbnail Library Manager will automatically load at startup.
• Time Format Select your preference  to use either Local or UTC time in the titling of images and in the Status bar

display
• Contest/DX/QSL Colors Selecting "Standard" will cause the large text to be written with a standard font. The color

will be white with a red outline. If "User Default is selected, these text items will use the setting last used in the text dialog box.
• JPG Compression Medium or High are probably the best choice. If Most is selected, you will notice more degradation in

image quality.
• PHG Compression Maximum is probably a good choice, but Average will result in a slightly better quality image.
• COM Port PTT If you want to use a Com port to control the transceiver PTT line , you select the Com port number

here.
• Image Save… Format.. Select the format you want the program to use for Save and Auto Save actions .
• Select Wave File (BUTTON) When clicked, this button brings down a standard dialog box that is used to select any

"WAV" file. You can then elect to play this file before or after your picture. If you record a "WAV" file with your station identifica-
tion , this is the file that should be selected.

• Select PlugIn Folder(BUTTON) This button will bring up a dialog box to select the folder containing plugin files.
These files have the extension 8bf. If you have many plugins on your system, you may have them in several folders. This is to
select the current default.

AutoRestart
If a picture starts and is then aborted by the sender, AutoRestart can be used to automatically correct the problem. Clicking on Au-
toRestart in the Options menu toggles the function ON and OFF.  When ON, a check mark will appear in the menu and the text
"+ReStart" will be added after the Horizontal Synch. information that is shown above the mode selection boxes in the Receive dialog.
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General Operation
Library Organization
Alt+T

The Thumbnail Library Manager (PixLib32) is a separate program that is tightly linked to WinPix32. It is called from within WinPix32
by clicking on the "Thumb" icon in the tool bar, selecting "Get Thumbnails" from the Action menu or using the short cut key.
The program is organized around a multiple library format. This organization allows any number of libraries to be open and displayed
at the same time.

If multiple instances of WinPix32 have been loaded, remember that the instance that last called the Thumbnail Library
Manager is the instance that will receive the pictures selected in the library.

If you want to send pictures to a specific instance of WinPix32, you should avoid using the Windows Task bar to transfer back to the
Thumbnail Library Manager. Instead use the "Thumb" icon since this will tell the Thumbnail Library Manager where to send the pic-
tures.
The size of a library is automatically adjusted to accommodate all of the supported images in the library's folder. If the
folder does not contain any images when the library is created, an empty library with room for 15 images is created.
As images are saved to the library and stored in the library's folder, the library expands to accommodate them. The size limit on any
one library is 500 images. Large libraries are not very useful. Instead you should create folders with different categories of images.
These could be organized by subject matter or by time of creation.

Library Status Bar
The Status Bar of the Thumbnail Library Manager displays the following information once a library has been loaded into the program.
As the cursor is moved over a thumbnail image in a library the following is displayed:

1. The date when the picture was last modified. This is the date it was created if it has not been modified and resaved since that
time.  It will also show the number of images in the library.

2. The title of the picture is displayed in the second panel.
3. The third panel is the size of the picture.

The raised panel at the far right is also a push button and will initially be labeled “Set Save Library”. When clicked, it will display the
name of the currently selected library and tell WinPix32 to save images to this library. Clicking on this button again with the same
library selected, will return the label to “Set Save Library”  If you close a library that is designated to receive saved images, the status
bar panel will again be labeled “Set Save Library” and WinPix32 will save images to its "Default" location.

Sending Images to WinPix32
The most common method of sending an image to WinPix32 is simply clicking on the thumbnail of the desired image.

If you are dealing with an "Overlay" library, you may want to send the image directly to the clipboard since this will be used in Win-
Pix32 to add the overlay to the picture. If you click on the title bar item (square) that is normally used to expand a window, the title bar
will get the added message "To Clipboard".  Now if you click on a thumbnail, a copy of the image will be sent to the clipboard. If you
click on the "square" the second time the library will return to "normal" operation.

While this function can be useful, it can also be troublesome.  If you are receiving a weak signal, a strong signal can trigger a restart
when you don't want one.

AutoRestart looks at any VIS code detected during the reception of a picture and determines two things.  First it evaluates if the new
picture size is the same as the existing window.  This is necessary because the new picture will simply overwrite the old in the exist-
ing window.  The second thing that is tested is the VIS Filter requirement                                                                       . If both are acceptable, the receive process will restart.

Scottie DX Prefer
Scottie DX and AVT 188 have the same VIS code.  If this menu item is enabled, the default will be Scottie DX.  If not, the default will
be AVT 188.  If you are using either of these modes it is important that you set this menu item.

Thumbnail Library Manager
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Editing an Individual Library Image
Right clicking on any thumbnail will bring up a dialog box to allow you to Rename or Delete the image. If you want to rename the im-
age, first type the new name and then click on “Rename”.  You do not need to enter the image format (extension) since this will not
be changed.  The dialog box also displays the location of the folder containing the library images.

Library Menu Summary

Library
The Library menu has the following selections:
• New Library --- Create a new library
• Open Library -- Open an existing library
• Close Library -- Close an open library.  This is the same as clicking on the "X" in the title bar.
• Rename Library
• Delete Library

Edit
The Edit menu contains four selections to be used for library maintenance                                                               :
• Sort/Refresh -- Sorts the library according to the selected sort criteria.  The sort order                                 is selected in the Options menu. This

function also removes images that are no longer in the folder.  If also adds any new images that were put into the folder but not
recorded in the folder's library.

• Multi Delete -- Allows you to delete multiple images from the library. The process consists of clicking on each image you want
to delete. The selected image will appear as a pressed button. If you change your mind, click again to remove that image from
the delete list. When all images have been selected, click on the title bar and the delete process will be completed.

• Multi Move -- Allows you to move multiple images from this library to another designated library.  The designated library                                                         is
same as the "Save" library listed in the right panel of the status bar. The process consists of clicking on each image you want
to move. The selected image will appear as a pressed button. If you change your mind, click again to remove that image from
the list. When all images have been selected, click on the title bar and the move process will be completed.

• Multi Copy -- This is similar to the Multi Move discussed above.  The only difference is that duplicate images will be created in
the new library while the source library remains unchanged.

Options
The Options menu contains two selections.
“Sort Order” sets the order in which your library will be sorted. If you select "Name" the library will be sorted alphabetically by name.
If "New->Old" is selected, the most recent images will be first in the library while the oldest will be last. If “Old->New” is selected, the
oldest images will be first in the library and the most recent images will be last.  When you use "Sort/Refresh" in the Edit menu, the
sort process will follow this selected option.

“Set as Startup Library” will designate the currently highlighted library as the one to be loaded when the program starts.

Thumbnail Library Manager Menu Details

New Library
When you select "New Library" from the Library menu, a dialog box will appear that allows you to select the folder that contains (or
will contain) the library images. It also allows you to select the type of library and the library's name.

Select the library type as either “Local” or “Remote”. This designation determines where the library data will be stored. A “Local” li-
brary stores its data in a folder called “Lib” which is a sub-folder under your installed WinPix32 folder. A “Remote” type stores its
data in the remote folder that contains the library’s images.

If the image location for a library is on a removable media (floppy, ZIP, etc.) you should use a “Remote” type for the library. CD-
ROMs that are “read only” can not be used for “Remote” type libraries.
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Open Library
Selecting "Open Library" from the Library menu will bring down a dialog box. The default folder will be Lib, which is the location for
all "Local" libraries.  The file type will be set to "GV3" which is the library extension used by PixLib32.  You can change the folder
location to locate any remote libraries.

If you have "Remote" style libraries that
were created with WinPix Pro, these will
have the extension "GVA".  You can find
and load these by clicking on the down
arrow next to the file type and selecting
"GVA". When one of these libraries is
opened, a "GV3" database will be cre-
ated and saved. In the future you can
then access the "GV3" format.

You will not be able to open any
"GVA" libraries that were created as
Local type and are not located in the
Lib directory of WinPix32.

If the image location is on a hard drive or a "read only" CD-ROM, use the “Local” type. This type has the advantage that all library
data is in a common location and easy to find.
If you try to access the images on a CD-ROM that is not present, an error message will tell you that the image could not
be found.

The total number of images in
any library is limited to 500. If
you have large folders for
your images you may want
to reorganize to use smaller
folders.

All of the supported images
in the selected folder will
become part of the library.  If
no supported images were in
the folder, an empty library
will be created.  The size of
this empty library will be set
to 15 images but the size will
automatically expand when
needed.
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Rename Library
You can rename any library by clicking on the "Rename Library" item in the Library menu. A simple dialog appears.  Enter the new
name and click on OK.

Hints and Reminders

Attached Dialog Boxes
When working with images, remember that the three dialog boxes that allow you to modify an image; add text to an image; and
draw shapes on an image are all attached to a specific image.  If you load or highlight another image, these dialog boxes will not
be active for the new image. You will notice that the tool bar items are no longer shown as "pressed" buttons.  If you activate these
buttons for the new image a new set of dialog boxes will be created.

If you do not close the dialog boxes as you are done working with a specific image, it is easy to be confused even
though the title on each of the dialog boxes includes the name of the image.

The suggestion is:
When you are done modifying an image, CLOSE THE DIALOG BOXES ASSOCIATED WITH THAT IMAGE.

Drag and Drop Loading
If you use "My Computer" or "Windows Explorer" to locate an image, you can move that image directly into WinPix32 by dragging
the image onto the WinPix32 window.  This is done by holding the left mouse button down while you move the cursor from the
image listing to any place on the WinPix32 window. When you release the mouse button, the picture will load into the program.

Use of the Clipboard for Temporary Storage

The clipboard is very useful for temporary storage but you must remember that it is easy to overwrite something you want to have
on the clipboard. Typical uses of the clipboard are:
• Saving the last image that was received to facilitate transferring that image to another instance of WinPix32 or another image

processing program.
• Saving an image that you want to later insert into another image.
• Holding an "overlay" image.
• Temporary storage of an image you have modified for transmission it you think you may want to send it again.
• Temporary storage of intermediate steps of a complex series of image modification.  This will prevent accidental loss of the

modifications due to "undo" use.

All of the above uses have value providing you remember what is currently on the clipboard.
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Auto-Save and Save Options

The AutoSave function in the Receive dialog can be turned on and off at any time. If you are operating unattended, you will probably
want this function on. However, if you are watching the images arrive, you can simply turn this function on only when a “good” pic-
ture is coming in. As soon as this picture is saved you can turn the function off until the next “keeper” arrives.

  The "Save" tool bar item may be preferred over the AutoSave function under certain conditions. When AutoSave is used, the
program must wait until the save process is complete before it can begin to receive a new image. Under certain DX conditions
this may be too much delay.

You can use the "Save" tool bar item at any time while the received image remains on the screen. This will not interfere
with the reception of a new image.  You can therefore manually save an image after the next reception has started.

Floppy and ZIP Drives for Image Storage

Floppy Disks

The capacity of floppy disks is quite limiting for SSTV image storage, but if you use the JPG format a single disk will likely handle 40
small format images. This suggests a creating a blank thumbnail library (remote type) on a new disk each week and then, following
each SSTV session, using “Multi-Delete” to delete those images you do not want to save. By doing this on a daily basis, you can
reduce the build up of “junk” and the disk should easily hold a week’s supply of images including the thumbnail library data.

ZIP Drives

ZIP drives and similar high capacity removable storage systems are ideal for image storage. In this case you can create a new direc-
tory each week with its own blank thumbnail library (remote type). Once a week you can use “Multi-Delete” to delete those images
you do not want to save. You could name each weekly directory and library with a name that gives its date of creation. A single ZIP
disk could easily handle a year’s worth of “keepers”.

Right Mouse Button
The right mouse button has uses in addition to the usual Windows functions:
• When using the "Inset" function , clicking on the right mouse button will expand the inset image from the clipboard to overlay

the entire image. This is useful for "overlay" images where a significant portion of the image is transparent.
• When drawing on an image you can use the right mouse button to make a "frame rectangle" fill the image.  This provides an

easy method for creating a simple frame.  Another use is to create a background pattern (other than transparent) on a blank
image.  Here a simple filled rectangle with shaded colors can be made to fill the blank image.

• A standard, though less known, Windows function is the "What's This?" access to the help file. When a dialog box is present,
you can move the cursor to an element of the dialog box and click using the right mouse button. This will result in a small box
appearing labeled "What's This?".  A click on this box will bring up a short explanation or that dialog box item.

Transparent Insets
If you hold a number key down when using the "Inset" function , you can make the inset semi-transparent. Holding numbers 1
through 5 will increase the "density" of the inset image. The color of the semi-transparent result will be the same color as the clip-
board image being inserted.  Holding numbers 6 through 0 will also increase the "density" of the inset image but now the color of the
semi-transparent result will follow the colors of the original image while taking on the luminance of the clipboard image being in-
serted.
The "best" effect will depend on the individual images involved so some experimentation is necessary.
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Printing QSL Cards
You can use your color printer to make QSL cards from SSTV images.  This is best done by first selecting a SSTV mode such as
Robot 72 (no header).  The image will then become 320x240. The superimposed QSL information can then be previewed before
sending the result to your printer.  The printer, of course, must have been set up for post card printing.

Maintaining Thumbnail Libraries
The Multi-Delete, Multi-Move and Multi-Copy functions in the Thumbnail Library Manager's Edit menu are the tools for maintaining
your libraries.

 For moving and copying images between libraries, you may want to maximize (expand) the Thumbnail Library Manager's window.
You can then move the individual libraries to be more visible.

One approach to image management is to use a single image library to collect "off the air" pictures.  If you then create various li-
braries that are organized by subject, you can spend a little time after "signing off" to delete those images you do not want to save
and move other images to the proper subject library.  A good location for subject libraries would be on a ZIP drive or similar high
capacity removable media.

If you have problems selecting images within a library it is possible that images in the folder were deleted using another
program. Try the “Sort/Refresh” command in the edit menu.  This rebuilds the library using the current contents of the
library folder.

Finding a Transmit Timing Error

If you have one of those rare sound cards that do not keep the same timing for Transmitting as Receiving,  one of the following three
methods will allow you to find the proper "Xmit Error" value without relying on a trial and error approach.

The following steps assume that you have already calibrated the receive timing and are receiving straight pictures using
a "Free Run" synch option.

1. If you have a VCR, you can use it to record the (AUDIO channel) output of your sound card when transmitting. You can then play
the sound back into the line input of your sound card and receive the picture. While receiving, you should enable the "Calibrate"
function just as you did when calibrating the Receive timing. At the end of the picture, the difference between the Old and New set-
tings will be the correction needed.  Watch out for minus numbers but as an example, if the new value is (-29) and the old value was
(-47), then the value to be entered into the "Xmit Error" box would be minus 18  [(-47) - (-29) = (-18)].   Of course you want to
click on "Keep Old" since the Receive is already properly calibrated.

2. If you do not have access to a VCR, you can do this same process with some other WinPix Pro or WinPix32 user. If this person
runs "Calibrate" and provides you with the Old and New calibration numbers, you can compute the proper value for the "Xmit Error"
entry.

3. If your sound card supports Full Duplex, you can just connect the sound card output to the its line input and send a picture to
yourself.  Use the “Calibrate” function and the calculations described in number 1 above to comput the “Xmit Error”.

Once the error value is computed, you can enter it into the "Xmit Error" box in the Signal Processing dialog box.

DO NOT TRY TO USE AN AUDIOCASSETTE RECORDER.  THEY ARE NOT ACCURATE ENOUGH.

Printing Two Pictures per Page
After selecting a "conventional" 4:3 aspect ratio SSTV image, set the printer for the "Portrait" orientation.  Now look at the Print Pre-
view.  You will see that the picture is positioned at the top of the page and it occupies about half of the page. If you print the picture
this way, you will have room for a second picture on the page.  Just turn the sheet over and reprint with another picture.

If the aspect ratio of the picture is substantially larger than that of the printer sheet, the program will scale for two pictures per sheet.
For all other cases, the program scales the picture to fit the printer page and centers it on the printer sheet.  Therefore to print one pic-
ture per sheet you should select "Landscape" for the printer orientation.
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What’s New in Versions 3.1 & 3.2

Cropping an Image with an Ellipse or a Rounded Rectangle
The Image/Crop/Rubber Band menu item now has four selections.  The first is “Rectangle” and this operates the same as the
rubber band crop option in version 3.0.  The second is “Ellipse” and the third is “Rounded Rectangle”.  These are used in a sim-
ilar manner but, as the mouse is moved to designate the crop area, the shape is either an ellipse or rounded rectangle.  When
the left mouse button is released, the picture will still be a rectangle but the area outside of the ellipse or rounded rectangle will
be “black”.  This area is transparent when the image is used as an overlay.  If you want to save the image, it is important
that the image be saved only in BMP, TIF or PNG format.  As is the case with all “overlay” images, saving in JPG will
cause the loss of the transparent feature.  BMP is the largest size file so TIF or PNG are the recommended formats.

Cropping an Image with an Irregular Area
The fourth selection in the Image/Crop/Rubber Band menu item is “Draw”.  Place the cursor at any desired start point and hold
the left mouse button down as you trace around the area you want to crop.  When the left mouse button is released, the program
will “close” the drawn area and crop the image to this irregular shape.  Again, the image will still be a rectangle but the area out-
side the irregular area will be transparent. (SEE PARAGRAPH ABOVE)

Header Options have been expanded
The first addition to the header options is the ability to select from one of ten header formats.  The first of these (number 0) is
the default WinPix32 header.  The remaining nine
are located in the “headers” folder under WinPix32.
They are named image1.bmp, image2.bmp, etc. and
they can be edited to create your own custom head-
ers.  The size of the edited headers should remain
as 320 x 16 pixels.  The program saves a sepa-
rate header message for each of the 10 headers.

You can have the program automatically enter time
and date information into the header by using stan-
dard Windows programming codes.  Note that the %
character prefixes each of the code letters.  If the
program detects a percent character in the message
it will also add either "UTC" or "Local" to your time
message.  You should experiment with this cod-
ing to make sure of the header message format as well as keeping the message a  reasonable length.

%a Abbreviated weekday name
%A Full weekday name
%b Abbreviated month name
%B Full month name
%c Date and time representation appropriate for your locale
%d Day of month as decimal number (01 – 31)
%H Hour in 24-hour format (00 – 23)
%I Hour in 12-hour format (01 – 12)
%j Day of year as decimal number (001 – 366)
%m Month as decimal number (01 – 12)
%M Minute as decimal number (00 – 59)
%p Current locale's A.M./P.M. indicator for 12-hour clock
%S Second as decimal number (00 – 59)
%U Week of year as decimal number, with Sunday as first day of week (00 – 51)
%w Weekday as decimal number (0 – 6; Sunday is 0)
%W Week of year as decimal number, with Monday as first day of week (00 – 51)
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%x Date representation for current locale
%X Time representation for current locale
%y Year without century, as decimal number (00 – 99)
%Y Year with century, as decimal number
%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown

 Favorite Fonts Selection
This feature has been added to make font selection faster.  Most computers have an extensive list of available fonts and looking for a
particular font is time consuming.  Now, when you click on “Font” in the “Annotate” dialog box, another dialog will appear that is
called “Favorite Fonts”.

This dialog has room for 12 of your favorite fonts.  When you first use this feature, all of the listed fonts will be the same.
You will need to “Replace” this default list with your own favorites.  To replace a particular font in the list, first highlight it by a

single click of the mouse.  Then click on “Replace”.  The familiar font dialog
will appear.  Select the font you want plus the point size and any features
such as bold, italic, or underline.  When you click on OK the font will be re-
placed in the list of favorites. Each of the fonts in the list contains infor-
mation on its size and such characteristics as “Bold”, “Italic” and/or
“Underline”.  You can therefore have several fonts with the same
name and just vary the size or other charcteristics.

If you highlight a font in the list and click on “Select”, this font will be used by
the program.  You can accomplish the same thing by double clicking on the
desired font name.

Adding Transparent Text and Shapes
A “Transparent” option has been added to the dialog boxes that are seen when either typing text or drawing shapes on an image.

When this option is selected for text, the added text will use the “Outline” background option but only the outline colors will appear.
The interior of the text will be transparent so the original image will show through.

When this option is selected for drawing shapes or lines, the function operates a little differently.  Again the “Outline” option will con-
trol the backgroud effect but, in most cases, you will likely select “None” to eliminate the background effect.  The shape or line that is
drawn will be “transparent” black.  Then, if this image is used to overlay another image, that image will show through the transparent
areas.

Typing Multiple Lines of Text
When typing text into a picture, a change has been made for the “Enter” key.  Now when the “Enter” key is used a new line of
text is started with the first character aligned under the start of the previous line.  To end the typing task, you must hit the “Enter”
key TWICE.
For vertical text, the next “line” will begin to the right of the starting character of the previous line.

Synch Start Revisions
The Synch Start option status will be remembered by the program.  If Synch Start is checked, it will reappear when wait-
ing for the next picture and the program will respond to Synch pulses as well as a VIS code. As with any method that
increases the ability to start a picture, a continuously used Synch Start will also result in more false starts. If QRM is
light this is a good option but, if QRM is heavy, Synch Start should be turned off.

If you miss the VIS code and DO NOT know the SSTV mode you are hearing, the "Synch Start" option can help identify the mode
and start receiving the picture.
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When you enable "Synch Start", the program looks for the timing between line synchronization pulses and attempts to find a SSTV
mode that matches the timing. If it finds a mode it will begin to receive the picture in that mode. The program will only examine those
modes allowed by the selected "VIS Filter".

Since the synch. pulses are much shorter than the VIS interval; they are more sensitive to noise.  As a result this method of finding
the mode is not as reliable as the VIS code. Under good signal conditions it works quite well.

Several SSTV modes have identical times between pulses so the program will select the first one it finds in the search pattern. If M3
is being sent, the program will select M1 since it has the same line timing and occurs first in the search pattern.

Tone Calibration using “Standard” Station
In addition to calibrating the sound card timing using another SSTV station, you can also use the signal from a "Standards" station
such as WWV.

Clicking on the "Tone Calibration" item in the Action menu will bring down a dialog box that controls the calibration process.

WWV Calibration:                               
WWV transmits on several frequencies (2.5, 5.0, 10.0, & 15.0 MHz) and propagation will determine the best frequency to use.
The station transmits using AM and must be received in that mode for this calibration function to work.  At the start of each
minute, a marker tone is transmitted.  Following this tone, a second tone is sent combined with one-second "ticks" and other sub-
tones.  At certain times during each hour, this tone is not transmitted and, instead, just the one-second "ticks" or voice
announcements are transmitted.  These intervals are of no use for calibration purposes.

Following the marker tone that is sent at the start of each minute, click on either "New" or "Update".  "New" is capable of perform-
ing a first-time calibration and can handle rather large sound card clock errors.  However, it is also more critical to QRN or QSB.
Since you probably have already calibrated your system against another SSTV station, you can select "Update" to increase the
accuracy of that calibration.

When started, the system will sample 20 seconds of the WWV tone and then use this data to compute the sound card's clock
error.  The bar at the bottom of the dialog box shows the progress of both the data gathering and the processing functions.  When
the process is completed, the two lower "buttons" in the dialog box will become active and will allow you to either "Save New" or
"Keep Old" calibration data.  If a significant difference is seen between the Old Correction and the New Correction, you may want
to repeat the calibration process to verify the result.  Noise or Fading on the WWV signal can cause errors in the calibration.

Under good signal conditions, you can expect the calibration results to vary less than 5 parts per million.  For small
format (320x240) pictures, this error would result in about plus or minus 0.2 pixels of slant.  For larger format pictures
(640x480) the variation would be plus or minus 0.8 pixels.  The intent of this calibration system is to reduce the slant
problem to less than one pixel.

Automatic Sort/Refresh of Thumbnail Library
When a thumbnail library is opened, the program determines if the contents of the library’s folder agree with the recorded contents
of the library.  If not, the program performs an automatic Sort/Refresh function to bring the library into agreement with the contents
of the folder.  This automatic Sort/Refresh will only occur if pictures have been deleted or added to the folder by “external” means.
If new pictures are saved to the library using WinPix32 or are deleted from the library using the Thumbnail Manager, the automatic
Sort/Refresh will not be needed.
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Digital Call Identification (CID)
The CID system is a method of displaying the sending station’s call sign.  One digital system was developed by KA1LPA and is
now in use in several of his programs. This CID code is sent just prior to the normal start tone and VIS code.  Programs that do
not support this feature will just ignore this code.

WinPix32 supports the transmission of your call sign as well as a one line message.  The message can be entered in the field at
the bottom of the Transmit Dialog box.  The message is limited to 25 characters, however, because the transmission speed is
slow, you should keep any message length to a minimum. Because the code uses only a 7 BITs, the message can not contain
“special” characters.  If you try to enter one of these an error message will occur.

A second CID system is used by ChromaPix and it sends a grayscale code that replaces the first line of the header/picture.

WinPix32 supports both of these CID systems both during transmission and reception.

The Receive Dialog box will display the sender’s call sign in the title of the dialog box.  Any message will be displayed in the field
at the bottom of the dialog box.

If the Synch Start function is used, the program will be looking for any synch pulse and will bypass the CID function
if one is detected.  Under noisy conditions this is quite common.

If the “AutoRestart” function acts to restart a picture, any CID code that was sent prior to the VIS code will be ig-
nored.  In this case only the ChromaPix approach will be decoded.

Since your call sign is being sent via the CID system the program will not add your call
sign to the picture if you elect to transmit without a header.

If the first line of the picture contains the CID code you can determine who sent the picture
at any time by placing the cursor on the picture and holding down the right mouse button.
The title of the picture will change to tell who sent it.

Mini-Log System
The Mini-Log function is NOT intended to be an official log.  It is a convenient way of keeping track of stations sending SSTV
pictures.  If the sending station has the CID function, the detected call will automatically be entered into the Mini-Log at the con-
clusion of the picture.  The log can be viewed by clicking on the button labeled “ViewLog” in the Receive Dialog box.

You can also manually add entries to the log as well as delete entries.  The log is limited to 1000 entries.  If this is exceeded, the
oldest entry is deleted to make room for the new entry.

The log entries automatically contain the date in LOCAL time.  If a message was a part of the CID code it is shown.  If the entry
was made manually, this is noted in the message area.
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Multiple Line entries into Text List
The text list now supports multiple lines.  To enter text that will span more than one line just put a simple backslash character to
separate the lines.  As an example:

Don\St.Paul\Minnesota\4

Will display as:

Don
St.Paul
Minnesota

The last backslash still sets the font scaling and in this case the font selected will keep the LONGEST line in the text
less than 40% of the picture width.  CAUTION —  If the line had ended with more than a single character after the last
backslash, this would have printed as a new line and not as a scaling command.

Full Duplex Sound - Xmit while Receive

Some sound cards can create sound at the same time as recording.  This full duplex operation allows the program to transmit
and receive at the same time.  This can be done even within the SAME instance of the program.

The Options/Other Options dialog box has a selection called "Xmit while Receive".  If this is checked, the program will attempt
to transmit while leaving any receive function active.  If the sound card does not support full duplex, you will get an error mes-
sage stating that the "Sound Card is Busy" when you attempt to transmit.  If this happens, just turn off the "Xmit while Receive"
option.

Transmitting while receiving has very few uses but it does provide a means of self calibrating sound cards that have separate
crystals for these functions (see page 39).  Another, though very limited, use could be sending pictures on VHF while monitor-
ing HF.

Additions to Options/Other Options Menu
• Xmit while Receive If your sound card supports full duplex this allows you to receive a picture at the same time as you

are transmitting.  The most common use for this is to calibrate a separate sound card crystal by sending a picture to your-
self.

• Clear Kills Synch Start When this is checked (default) the Clear button will turn off Synch Start.  Your prefer-
rence here!

Short Cut Keys
Additional short cut keys have been added to assist during reception and transmission.

Transmit:
The T or t key will start transmission.
The S or s key will stop transmission.

Receive:
The C or c key will clear the picture being painted.
The S or s key will stop reception of this picture.

IMPORTANT:
Key strokes are sent from a picture window back to its dialog box.  If you have selected another picture it will not be
attached to a dialog box and the short cut keys will not work.
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Version 3.6 Additions

Addition to Edit Menu
You can now clear the contents of the clipboard with the Edit Menu item “Clear Clipboard”.

Clearing the contents of the MINI-LOG
A button has been added to the MINI-LOG dialog box to allow you to delete all of the entries in the log.  When this button is
clicked, the program will display a “warning” dialog to verify that you indeed want to remove all of the entries.

Prefix and Suffix Additions to your Call for Portable Operation
Since requirements vary for indicating operation in another country or call district, the program now allows you to add a prefix or
suffix to your registered call sign for portable operation. The call displayed in the header and send by CW will include any prefix
or suffix.  The CID that is imbedded in the picture will only be the registered call sign.

Version 3.7 & 3.8 Additions

Manual Sort function in Thumbnail Manager
The Manual Sort function is used to change the order of pictures within a library independent of picture name or date.  This fa-
cilitates the creation of a slide show presentation based on picture content.

When "Manual Sort" is clicked, the library goes into a manual sort mode.  The library will stay in this mode until the title bar is
clicked.  The cursor will be the "standard" arrow.

1. Place the cursor on the picture to be moved and left click.
2. Move the cursor to the "move to" location.  The cursor will be a "four pointed arrow".
3. Left click on the picture at the "move to" location.
4. The picture will be moved to the location at the LEFT of the above picture.

After the picture is moved, the library will remain in the "manual sort" mode so another picture can be moved if desired.  RE-
MEMBER TO CLICK ON THE TITLE BAR to turn off the "manual sort" mode.

Slide Show function in Thumbnail Manager
The Slide Show function allows you to view the contents of an image library in "full screen" format.  Using "Slide Show" is very
simple.

Version 3.7
Clicking on the RIGHT mouse button advances to the next image in the library.  Clicking the LEFT mouse button moves to the
prior image. DOUBLE CLICKING the LEFT mouse button stops the slide show.

Version 3.8
Clicking on the RIGHT mouse button advances to the next image in the library.  Clicking the RIGHT mouse button while holding
the SHIFT key moves to the prior image. DOUBLE CLICKING the RIGHT mouse button stops the slide show. The LEFT
mouse button is used to insert the image being viewed into WinPix32.
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Version 3.7 & 3.8

• Starting Slide:The options menu allows you to select your preferred starting point for the slide show.  The first image can be
either the first image ("From Beginning" checked) in the library's current sort order or it can be the last image sent from the
library to WinPix32.  This is the image that is shown "indented".

• Viewing Order: Each use of the right mouse button advances through the library in the current sort order.  When the
last image is reached, the next image to be displayed will be the first image in the library. Similarly, using the left mouse button
cycles through the library in reverse order.

• Picture Size: Three selections are available.  The selected option will be displayed with a check mark ahead of the selection.
If "No Expansion" was selected, all images smaller than your full screen display will be shown in actual size.  Images larger
than your full screen display will be reduced to fit the screen.  If "Max 2 X" was selected, the maximum expansion of any image
will be a factor of two.  A 320 x 240 image will become 640 x 480 rather than becoming a very large and ugly image on a high
resolution screen.   If "Full Screen (best fit)" was selected, all images will be altered to fit the full screen display. If you have a
large number of images that are much smaller than the full screen, you will probably not want this selection.  A 320x240 image,
expanded to fit a 1024x768 screen, just looks ugly.

• Picture Title: If "Picture Title" is checked, the title of each image will appear in the upper left corner of the picture. 

Many image sources, such as the higher resolution digital cameras, create images that are too large to be viewed within WinPix32
without making them smaller.  The Slide Show function allows you to view your "holiday" photographs at the maximum resolution that your
computer will support.

Putting a Picture Title into the Header
Version 3.8
The Options/Header Options dialog box has an additional entry.  If the check box under the word  “Title” is checked, the Header
Message will display “>> Picture Title <<“.  If you then transmit the picture, the header message will be the title of the picture being
sent.


